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Setup program version 1.0.0

About this document

Scope and purpose

ModusToolbox™ software is a set of tools and libraries that support device configuration and application
development. These tools enable you to integrate our devices into your existing development methodology.
This document provides information and instructions for using the ModusToolbox™ Setup program.

Document conventions
Convention Explanation
Bold Emphasizes heading levels, column headings, menus and sub-menus.

Italics

Denotes file names and paths.

Courier New

Denotes APIs, functions, interrupt handlers, events, data types, error handlers, file/folder names,
directories, command line inputs, code snippets.

File > New

Indicates that a cascading sub-menu opens when you select a menu item.

Reference documents

Refer to the following documents for more information as needed:

e ModusToolbox™ tools package installation guide —Provides information and instructions about installing

the tools package on Windows, Linux, and macOS.

e ModusToolbox™ tools package user guide —Provides information about all the tools included with

ModusToolbox™ tools package.

e Dashboard user guide -Provides specific information about the Dashboard tool.
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Introduction

1 Introduction

The ModusToolbox™ Setup program was created for ModusToolbox™ tools package version 3.2 and later to
improve the getting started user experience for installing ModusToolbox™ and its various packages. It also
provides a simple path for updating versions and installing new content when required.

ModusToolbox™ Setup 1.0 = O >
File View Help
I:%Logout Legged in {@}Prefarancas
Base Packages

[0 ModusToolbox Tools Package 320

Additional Packages

[1 ModusTeclbox Progtoels 1.0.0

[J ModusToolbox Machine Learning Pack 200 ~

ModusToolbox™ Software

Discovered available tocl 'ModusToolbox Pregtocls’, version 1.0.0.730 -~
Discovered available toel 'ModusTeolbox Tools Package', version 3.2.0.13400
Parse Local IDC Registry

Updated the tool list

Mext »

The Setup program provides a flexible installation experience and addresses two important problems:

e Itensuresyou can quickly get all the software you need to start developing applications.

e It helps you manage all these pieces, learn about new packages and install them, and keep them up to date.

The Setup program improves the user experience in the following main areas:
e Duringinitial installation, it will allow you to select the pieces of ModusToolbox™ software that interest you.
This includes platform tools, patches, packs and programming tools.

e During development, it will give you an easy way to track versions and update/install/uninstall content as
needed.

e If you attempt to create an application or add a library that requires content not currently installed, the
associated tools (including Project Creator and Library Manager) will inform you of the required packages.

1.1 Installing the Setup program

The Setup program is available on the Infineon Developer Center (IDC) website here:
https://softwaretools.infineon.com/tools/com.ifx.tb.tool.modustoolboxsetup. Download the installer for your
operating system and run it as applicable for your system.

1.1.1 System requirements

ModusToolbox™ Setup program is supported on the following 64-bit operating systems:

Host OS Supported Recommended
Windows 10,11 11

macOS Monterey and Ventura (Intel processors) Monterey

Linux Ubuntu 20.04 LTS and 22.04 LTS 22.04 LTS
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1.1.2 Prerequisites

The ModusToolbox™ Setup program depends on the Infineon Developer Center Launcher Service. This service
is automatically installed by the ModusToolbox™ Setup installer.

On Ubuntu Linux, the Setup program depends on the “sudo” and “apt” utilities to perform the automated
installation of the ModusToolbox™ packages. Additionally, “gnome-terminal” application is used to perform
the interactive uninstallation of the packages and self-update of the tool. These are standard tools provided in
Linux.

On macOS, the Setup program depends on the “sudo” and “Installer” utilities to perform the automated
installation of the packages. Additionally, “osascript” utility is used to perform the uninstallation. These utilities
are provided as part of default macOS installation.

1.1.3 Installation process

Follow the prompts from the installer to install the Setup program.

1.2 Launching the Setup program
You can launch the Setup program in various ways:

e Ifyou have notinstalled the ModusToolbox™ tools package, run the Setup program executable as
applicable for your operating system.

¢ Ifyou have installed the ModusToolbox™ tools package, you can click the link from the ModusToolbox™
Dashboard.

o
Learn Setup Tool

ey . § 'N’ Setup Tool improves your experience during development:
® @) \ :
) 4O ST

nch Tool

0
“,' \ (
- ) "‘
- / « } Create
MOdUSTOOIbO)\ Create a new application for ...

Also, when using other ModusToolbox™ tools such as PrOJect Creator or Library Manager, if the application
does not have a required asset, follow the prompt to launch the Setup program and install the required
package.
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2 Installing and updating ModusToolbox™ packages

After the Setup program has been installed, you can use it to install and update various ModusToolbox™
packages.

2.1 Select packages

The Setup program gathers package data from the IDC online and local tools registry, and then displays all
installed and available packages along with version information. For the purposes of this document, a package
includes ModusToolbox™ platform tools, patches, packs, programming tools, and other tools such as the
Memory Analyzer. The Setup program displays a list of the available packages, grouped by two categories:

e Base Packages: This includes the ModusToolbox™ tools packages and patches.

e Additional Packages: This includes all other packages relevant to the ModusToolbox™ ecosystem, including
programming tools, technology packs, early access packs, and auxiliary tools.

Select items to be installed, updated and/or uninstalled, and click Next >.

MeodusToolbox™ Setup 1.0

File View Help

E% Logout  Logged in {é} Preferences
Base Packages

MaodusToolbox Tools Package 320 ~
[[1 MedusToolbox Tools Package 3.1.0 Will be uninstalled

Additional Packages

MaodusToolbox™ Pregramming tools 1.00 Will be installed

ModusToolbox Machine Learning Pack 3.00

ModusToolbox™ Software

Discovered installed tool ‘"ModusToolbox Machine Learning Pack’, version 3.0.0.1525 ~
Discovered installed tool ‘ModusToolbox Tocls Package', version 2.4.0.5972

Discovered installed tool ‘ModusToolbex Tocls Package', version 3.0.0.9293

Discovered installed tool ‘ModusToolbox™ Tools Package 3.2', version 3.2.0.14384

Discovered installed tool ‘"ModusToolbox Tools Package’, version 3.1.0.12290

Updated the tool list W

Next >

o Items with a check mark will be installed or updated if not already installed and up to date.

e Items with no check mark will be uninstalled if they are currently installed.
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2.2 Verify/configure

The Setup program then shows the actions that will be performed when you proceed with the install/update.
Each package provides links to Release Notes and License information. There is also an option to customize the
installation. For example, on Windows and macOS the installation scope of the package can be customized.

MeodusTeolbox™ Setup 1.0

File View Help

[—)chcut Legged in é:é}li’references

The following packages will be installad:

MedusToolbox Tools Package 320 Customize installation
Release notes License - Default options

The following packages will be updated:

ModusToolbox Machine Learning Pack

2.0.0
Release notes License
The following packages will be uninstalled:
MedusToolbox™ Teels Package 3.1 310
= =
Updated the toel list )

'‘MeodusToolbox Machine Learning Pack' version 2.0.0.444 was selected for update (from version 1.0.0,200)
‘ModusToolbox™ Tools Package 3.1' version 3.1.0.12257 was selected for uninstallation
'‘ModusToolbox Tools Package' version 3.2.0.13400 was selected for installation hd

| agree to the licenses of packages | have selected < Back Start

Click the checkbox to accept the license agreements, and then click Start. This shows the progess of all the
packages being installed, updated, and removed.

ModusToolbox™ Setup 1.0

File View Help
E—)chcut Logged in {@}Pn&ference:
Progress
ModusToolbox™ Tools Package 31.0 a" Downloading - 23.82%
ModusToolbox™ Programming teols 1.0.0 Waiting for installation
'ModusToolbox™ Tools Package' version 3.1.0.12257 was selected for installation A
Download package 'com.ifx.tb.tool.modustoolbox' - '3.1.0.12257
Download package 'com.ifx.th.tool.modustoolboxprogtools' - "1.0.0.714'
Successfully downloaded package 'com.ifi.th.toel.modustoclboxprogtecls' - '1.0.0.714' v
Cancel

Note that pressing the Cancel button will not affect install operations that have already started, only pending
install operations will be stopped.
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| E—) Logout Logged in {é}Pr&ferences

Setup has finished installing the requested packages.
Click Finish to exit Setup.

Run ModusToolbox™ Programming tools

[ Discovered installed tool ModusIooIDoX ™ 100Is Package 3.0.U, version 3.0.0.9309
Discovered installed tocl "ModusToolbox™ Tools Patch for 3.0°, version 3.0.1.10962
Discovered installed tool ‘ModusToolbox™ Tools Package 3.1', version 3.1.0.12257

Discovered installed tool ‘ModusToolbox Programming Toals', version 1.0.0.714
lindztad tha tanl lict

< Back Finish

When all packages are installed/updated/uninstalled the final launch screen is shown. Click Finish to close the
Setup program or click Back to return to the select packages window.

The final screen also allows you to specify which installed tool(s) should be opened after the Setup program
exits.
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3 GUI description
The main GUI window of the ModusToolbox™ Setup program contains the following elements:

e Main menu
e Main toolbar
e Toolview

e Logpanel

e Actions bar

ModusToolbox™ Setup 1.0

File View Help

E%Logout Logged in {g}Preferences
Base Packages

MedusToolbox Teols Package 3.2.0 Will be installed

MedusToolbox™ Tools Package 3.1 310

Additional Packages

ModusToolbox Pregtools 1.00
ModusToolbox Machine Learning Pack 2.0.0 ~ Wil be updated
[0 ModusTeolbox™ CYW955913 Early Access Pack 1.0.0 ~ | Will be uninstalled

ModusTeolbex™ Software

Updated the tool list G
'MedusToolbox Tools Package' version 3.2.0.13400 was selected for installation

'MedusToolbox Machine Learning Pack' version 2.0.0.444 was selected for update (from version 1.0.0.200)

'MedusToolbox™ CVYW955913 Early Access Pack' version 1.0.0.242 was selected for uninstallation hd

Mext »

3.1 Menus

The main application menu consists of multiple menu item groups as defined below.

3.1.1 File

The File menu consists of the following menu items:

Menu item Description

Check for updates Manually checks to see if there are any updates to the Setup program itself. The tool can be
configured to check for updates on startup. If updates are available, the ModusToolbox™ Setup
Installer package is downloaded and executed once the program is closed.

Preferences Opens the Preferences dialog.

Login / Logout The login function provides access to installable packages from the IDC.

The login is the same as the IDC login. If you don't already have an account, you can create one
at https://community.infineon.com.

Exit Exits the ModusToolbox™ Setup program.
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3.1.2 View

The View menu allows you to navigate between different views. For example, it allows to switch between the
select packages and configure screens.

3.1.3 Help

The Help menu consists of the following menu items:

e View Help - Opens this document.

e About - Opens the About box for version information, with links to open https://www.infineon.com and the
current session log file.

3.2 Main toolbar

The main toolbar consists of Login, Logout and Preferences buttons. While Login is visible, Logout is not. When
you are logged in, your email address is displayed along with the Logout button.

The Preferences button opens the Preferences dialog.

3.3 Log panel

The log panel area displays the information messages relevant for the end user. Examples of events that
produce messages to the panel view:

e Userloggedin/logged out

e Completed/failed downloading the tool data from the online tool registry

e Package was selected/deselected in the tool selection view

e Dependent package version was changed (to satisfy the updated tool dependency constraints)

e Tool configuration (installation mode, target directory was changed)

e Tool download started/finished

e Toolinstallation/uninstallation started/finished
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3.4 Preferences dialog

You can open the Preferences dialog from the main menu or main toolbar button.

Preferences - ModusToolbox™ Setup 1.0

Update site URL: |https://softwaretools.infineon.com/api/vi/tools/

Check for updates on start

Restore Defaults| oK Cancel

There are two settings available:

e Update site URL: the address of the IDC Online Tools registry. Usually there is no need to customize this
address to a non-default URL.

e Check for updates on start: disable this option to prevent the program from automatically checking for an
update at each start.

Use the Restore Defaults button to revert the options back to their default values.
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4 Troubleshooting

4.1 Unable to login with Infineon Developer account

Open https://community.infineon.com/ in the browser and create an account. Then, use the Login button to
open the login form and enter the login and password.

4.2 Unable to download the packages (network issue)

Open https://www.infineon.com/modustoolbox, download the packages from the ModusToolbox™ Software,
and install manually.

Alternatively, start the ModusToolbox™ Setup program on a different PC with a network connection, install the
required packages, and copy the installer(s) from the package download directory to your PC.

Location of the download directory:

Windows %USERPROFILE%\AppData\Local\Infineon_Technologies_AG\Infineon-Toolbox\Tools

Linux SHOME/.local/share/Infineon_Technologies_AG/Infineon-Toolbox/Tools

macOS SHOME/Library/Application Support/Infineon_Technologies_AG/Infineon-Toolbox/Tools
4.3 Infineon Launcher Service doesn’t function properly

Close the ModusToolbox™ Setup program.
Close the Launcher Service using the system tray icon.

Start the ModusToolbox™ Setup program again.

4.4 ModusToolbox™ Setup program is stuck downloading or installing a
program

Close the running processes of the ModusToolbox™ Setup program and Infineon Launcher Service using the
Task Manager.

Start the ModusToolbox™ Setup program again.
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Revision | Date Description
o 2023-09-27 New document.
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Important notice

The information given in this document shall in no
event be regarded as a guarantee of conditions or
characteristics (“Beschaffenheitsgarantie”)

With respect to any examples, hints or any typical
values stated herein and/or any information
regarding the application of the product, Infineon
Technologies hereby disclaims any and all
warranties and liabilities of any kind, including
without limitation warranties of non-infringement
of intellectual property rights of any third party.

In addition, any information given in this document
is subject to customer’s compliance with its
obligations stated in this document and any
applicable legal requirements, norms and
standards concerning customer’s products and any
use of the product of Infineon Technologies in
customer’s applications.

The data contained in this document is exclusively
intended for technically trained staff. It is the
responsibility of customer’s technical departments
to evaluate the suitability of the product for the
intended application and the completeness of the
product information given in this document with
respect to such application.

Warnings

Due to technical requirements products may contain
dangerous substances. For information on the types
in question please contact your nearest Infineon
Technologies office.

Except as otherwise explicitly approved by Infineon
Technologies in a written document signed by
authorized representatives of Infineon Technologies,
Infineon Technologies’ products may not be used in
any applications where a failure of the product or any
consequences of the use thereof can reasonably be
expected to result in personal injury.
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